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Abstract: Hurricane Sandy caused dramatic change in the shoreline of the New Jersey coast. In this 

study Digital Surface Models (DSMs) of the New Jersey coast are created from publicly available LiDAR 

data acquired before and after the hurricane. These DSMs are used to assess height changes and 

determine areas of erosion and deposition in the beach zone. Lidar has been used in storm damage 

assessment to great effect, and a brief literature review and discussion of the strengths and limitations 

of the technique is included. The findings show that some dune destruction has certainly occurred on 

the New Jersey coast as a result of the storm, but further study is required to investigate this pattern 

more widely. 
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1 INTRODUCTION 

1.1 THE PROBLEM 
 

Shorelines do more than provide a place a recreation – they are a critical morphological barrier to 

flooding of infrastructure, assist in the maintenance of freshwater tables against saltwater intrusion 

(Saye et al., 2005, p. 128), frequently have cultural heritage values, and are important ecological 

habitats in their own right. Perhaps the most critical component of this list in the near future will be 

the role of shorelines as barriers to flooding of settled areas. Worldwide, coastal zones host between 

15% and 40% of the human population (Roebeling et al., 2018, p. 175). Dune systems are adaptable 

mobile barriers that protect settled areas from storm surge, but extreme events can overwhelm the 

capacity of the shoreline to provide this barrier (Saye et al., 2005).  

Within the coming decades, shorelines are likely to face pressures from sea level rise and climate 

change (Burvingt et al., 2017, p. 722). While it is likely that the mobile nature of dune systems (Jackson 

et al., 2005) will be able to respond to the gradual sea level rise process in the short term, an increase 

in extreme weather events such as hurricanes that is thought to be concomitant with climate change 

(Emanuel, 2013) will put more immediate pressures on shoreline morphology (Burvingt et al., 2017; 

Fletcher et al., 2016). Extreme weather events such as hurricanes can overwhelm the system’s 

capacity to respond, and the shoreline can be heavily eroded, reducing its capacity to act as an 

important barrier to flooding of settled areas. At the same time, increasing human population pressure 

is likely to increase the density of these vulnerable built up areas close to the shoreline (Fletcher et 

al., 2016, p. 1023). With this in mind, it is important that we characterise the effect of extreme weather 

events such as hurricanes on the morphology of shorelines, with particular mind to understanding 

how they might reduce the shorelines capacity to act as a morphological barrier to flooding and 

inundation of built up areas landward of the shoreline zone. 

Shoreline erosion and attempts at mitigation pose a significant cost to managing bodies. For example, 

for the 1990 – 2020 period, public expenditure on coastline protection in the EU was estimated to 

exceed 5 billion Euros (Sellick, 2006). In England and Wales, approximately GBP 50 million is spent 

annually to mitigate coastal erosion (Penning-Rowsell & Pardoe, 2015).  

 

  



5 
 

1.2 BACKGROUND 
 

1.2.1 Background to the Storm Event 

 

The U.S. East coast is regularly under threat from tropical and ex-tropical cyclones and hurricanes (Liu 

et al., 2020). Shoreline erosion, coupled with storm surge, creates a very real threat of coastal 

inundation, consequential property and infrastructure damage, and indeed risk to human life. In this 

report I will analyse the effect of Hurricane Sandy (Figure 1) that made landfall on the New Jersey 

coast in October of 2012 (Sullivan & Uccellini, 2013). This storm resulted in enormous impacts to life 

and property in both the Caribbean and the continental United States, and the effects extended as far 

west as Wisconsin (Sullivan & Uccellini, 2013, p. iv), but the analysis in this report will be confined to 

the New Jersey coast, as described in section 1.2.2. 

 

 

Figure 1. Hurricane Sandy Path – redrawn from (Blake et al., 2013, p. 127) 
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1.2.2 The Study Area 

 

The study area is described in Figure 2. Please note that the actual analysis was only conducted at the 

beach zone as defined by beach sand, and further limited by those areas of the beach zone covered 

by our LiDAR dataset (shown in more detail, Figure 12).  

 

Figure 2. Study area along the New Jersey Coast. 

 

1.2.3 LiDAR and Shoreline Erosion Research 

 

Compared to other remote sensing techniques, the high level of spatial detail makes LiDAR an 

excellent tool to analyse changes in elevation profiles, and thereby to assess shoreline erosion. 

Especially, LiDAR datasets are characterised by highly accurate elevation measurements in comparison 

to other remote sensing techniques, which is of direct and obvious relevance to elevation analyses. 

LiDAR has been used extensively in morphological studies of coastal areas, and I will present a 

selection of key studies here. 

Farris et al. discuss the US Geological Survey’s response to the hurricanes of 2005 that included Katrina 

(Farris et al., 2007). They present diverse cases using remote sensing, and those using LiDAR discuss 

its advantages compared to other techniques. The Gesch article in this publication discusses using 

LiDAR to quickly estimate inundation in the days immediately after Hurricane Katrina (Gesch, 2007, 

pp. 53–55). Flood inundation depth was calculated using a LiDAR derived elevation profile combined 

with water level data. Gesch emphasises the superiority of LiDAR over other remote sensing methods 

for data acquisition where vertical accuracy and high spatial resolution is required (Gesch, 2007, p. 
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56). As a shoreline is defined by its elevation relative to tide height (Yang, 2008, p. 300), any 

assessment of shoreline erosion requires high vertical accuracy and high spatial resolution.  

The article by Sallenger et al. in the same volume emphasises that the primary advantages of LiDAR 

over ground surveys are the speed of acquisition and high spatial density (Sallenger et al., 2007, p. 

114). In the context of a time-critical response to an environmental disaster, LiDAR is an excellent tool 

precisely for its speed of acquisition. No other method with high spatial density and vertical accuracy 

can compete, with perhaps the exception of photogrammetry. 

Photogrammetry provides one viable alternative to capture the kind of datasets needed to assess 

storm damage. Bevan et al. describe the trade-off between these two methods, with LiDAR being 

prohibitively expensive to acquire, and stereo-photogrammetry having limited spatial coverage OR 

resolution (George Bevan et al., 2012). Since the time of publication however, the availability of UAV 

based LiDAR has largely negated the expense of acquisition (e.g. Lee & Park, 2019). 

Pye and Blott use LiDAR to analyse which parts of a dune system experienced the most erosion, finding 

that this occurred where the upper beach was less than 25m wide (Pye & Blott, 2016). This study is 

relevant to this report in that is emphasises that erosion occurs at different rates across a study area. 

Differential erosion is evident in the study area analysed in this report, and it is hoped that by using 

cross-shoreline elevation profiles these patterns can be investigated. 

Cross-shoreline elevation profiles have been employed by Masselink et al. to analyse differential 

erosion in the dune, back-shore, and intertidal zones (Masselink et al., 2016). They employed 224 

individual cross-shore transects from 38 beaches. Saye et al. also used cross-shore profiles to 

investigate zonal differences in erosion and deposition (Saye et al., 2005). Houser et al. use both along-

shore profiles, and cross-shore profiles to demonstrate morphological changes (Houser et al., 2015). 

Elevation change can be calculated using image differencing between a pre and post storm LiDAR 

dataset. Andrews et al. present their method to achieve this and found that, in their study, the greatest 

elevation reduction, and therefore erosion occurred along the seaward faces of dunes (Andrews et 

al., 2002). 

Other studies take the analysis a step further and calculate sediment volume change pre and post 

storm, using LiDAR image differencing. Burvingt et al. conducted a sophisticated analysis, where they 

considered sediment volumetric change at different levels along the beach and found that beaches 

were either flattening (with upper beach erosion and lower beach accretion) or steepening (upper 

beach accretion and lower beach erosion) (Burvingt et al., 2017, pp. 731–732). Other volumetric 

change studies of shoreline morphology using LiDAR include Woolard and Colby (2002) and Houser et 

al. (2015). 

Stoker et al used LiDAR to model the inundation of a landscape due to storm surge (Stoker et al., 2009). 

Richter et al. (2013) present a fascinating technique that uses moving Laplace and Sobel filters to 

detect abrupt height changes in their lidar data, and thereby identify the movement of dune cliffs over 

time. Whist outside of the scope of this report, these two studies demonstrate that the high spatial 

resolution and vertical accuracy of LiDAR have opened up new avenues of research into shoreline 

morphological change. 
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1.3 AIM AND OBJECTIVES 
 

The aim of this research is to determine the extent and character of shoreline change along the New 

Jersey coast due to Hurricane Sandy.  In order to achieve this aim I will use LiDAR datasets acquired 

before and after the storm to derive digital elevation models (DEMs). From these DEMs I will model 

the elevation change along the shoreline. Whilst the available LiDAR data extends beyond the 

shoreline zone, I will restrict the analysis to the area defined by beach sand, using multispectral 

classification of (non-contemporaneous) Sentinel imagery to derive a study area extent. To examine 

the character of the shoreline change in detail, I will investigate the shoreline in the Borough of Deal 

with cross-shoreline elevation change profiles. 
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1.4 DATASETS AND EQUIPMENT 
 

The following datasets have been used in this report. 

1.4.1 EAARL-B Coastal Topography--Eastern New Jersey, Hurricane Sandy, 2012: First Surface, Pre-

Sandy 

Inspection of the metadata does not clearly indicate the date the original data was acquired.  This is 

not ideal, but does not preclude analysis as it is emphasised that the data is ‘Pre-Sandy’. The data has 

been provided by the National Oceanic and Atmospheric Administration Office for Coastal 

Management. Data is in EPSG:5703 coordinate reference system. 

The data is in the form of an xyz point cloud, and the extent is of a portion of the New Jersey coastline, 

pre-Hurricane Sandy. The data was acquired with aircraft based LiDAR called the Experimental 

Advanced Airborne Research Lidar (EAARL-B). Average points spacing is 0.5-1.6m. 

This dataset consists of 10x10km extent tiles. Importantly, the metadata reveals that the entire 

dataset was captured in the same flight, was processed together and only subsequently split into tiles, 

so I do boundary issues between the tiles should be minimal. 

The dataset is accessible at https://coast.noaa.gov/htdata/lidar1_z/geoid12a/data/3658/ 

 

1.4.2 2012 USGS EAARL-B Coastal Topography: Post-Sandy, First Surface (NJ) 

The post-sandy dataset has been derived using the same sensor and processing method as the pro-

sandy dataset. This is ideal for our analysis. 

 

1.4.3 Sentinel Imagery, pre and post Sandy. 

Sentinel Imagery will be used to restrict our analysis to the beach areas of the study area. A 

unsupervised classification method will be used to spectrally classify the Sentinel images and derive 

an extent shape for the beach area (see Section 2.3.2). 

Sentinel imagery is not available contemporaneous with the study period. I have chosen recent 

imagery that covers the study area, and has <5% cloud cover. 

Two adjacent and contemporaneous Sentinel 2 scenes were chosen: 

S2A_MSIL2A_20200308T154101_N0214_R011_T18TWK_20200308T200723 

S2A_MSIL2A_20200308T154101_N0214_R011_T18SWJ_20200308T200723 

They were both acquired on the 8th of March 2020, with the same sensor. 

1.4.4 Equipment 

All data processing, analysis, and visualisation was carried out on a Microsoft Surface Book 2, with an 

Intel i7 processor and 16gb of RAM, running a Windows 10 operating system. Software used includes: 

- R (and R-Studio as GUI) 

- QGIS 3.12.2 

- GRASS GIS 7 

- ArcMap 10.5, Spatial Analyst extension  

https://coast.noaa.gov/htdata/lidar1_z/geoid12a/data/3658/
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2 METHOD 

 

2.1 CREATION OF DIGITAL SURFACE MODELS 
 

The aim for this step was to take the raw LiDAR data, consisting of .las tiles and metadata, and to 

create digital surface models of the study area in its pre-hurricane and post-hurricane state. LiDAR 

processing was performed in R (R Core Team, 2013).   

The ‘grid_canopy’ tool from the ‘lidR’ R package was used to create Digital Surface Models from the 

raw LiDAR data. This allows a choice of algorithms, and the ‘dsmtin’ Digital Surface Model Algorithm 

was used (see https://rdrr.io/cran/lidR/man/dsmtin.html). Output resolution was set to 2m to provide 

a balance between high resolution and ease of data processing and speed. 

A critical decision was made at this point in the method. Unique amongst remote sensing methods, 

LiDAR data has multiple returns, which allows users to map the surface of the terrain (a Digital Terrain 

Model) or objects above this surface, commonly vegetation and buildings (a Digital Surface Model). 

As part of the intention of this report is to study the damage to all parts of the shoreline, it was decided 

to examine the change in the first return values, or between Digital Surface Models. For a strict 

analysis of dune morphology, different results may be obtained by deriving Digital Terrain Models and 

performing difference analysis on these (please see Section  4.2 for a discussion of this point). 

Two Digital Surface Models were created: 

DSM_PRE_FULL.tif, a 2x2m raster dataset, with cell values representing local height pre-hurricane. 

DSM_POST_FULL.tif, a 2x2m raster dataset, with cell values representing local height post-hurricane. 

Please see Section 7.1 of this report for the R code used to derive the Digital Surface Models. 

2.2 DERIVING ELEVATION CHANGE 

 

This step was also performed in R (R Core Team, 2013). The Digital Surface Models created in Section 

2.1 consist of rasters with height values specified in meters. The elevation change raster was derived 

using a basic mathematical operation in R, whereby the height of each cell in the PRE DSM was 

subtracted from the height of each cell in the POST DSM. The resulting raster shows the height 

difference due to the storm for each 2x2m cell. 

Please see Section 7.2 of this report for the code. 

 

  

https://rdrr.io/cran/lidR/man/dsmtin.html
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2.3 DEFINING THE BEACH AREA 
 

2.3.1 Background 

 

The study area was restricted to the beach zone for two reasons. Firstly, by restricting the study to 

this area, we could focus our analysis on deposition and erosion of this zone, without being distracted 

by changes in other areas. Specifically, the range of height change values in our dataset would be 

specific to our question, and would allow our visualisations to reflect the changes that we are 

interested in in greatest detail, without being distracted by more extreme changes in other parts of 

the image, such as building destruction in the built environment landward of the dunes. 

Secondly, the study area was restricted to the beach zone as these processes are computationally and 

memory intensive. It could be said in the past that the large size of LiDAR datasets was a disadvantage, 

but with the constant development and availability of processing power this is becoming less of an 

issue.  

2.3.2 Unsupervised Classification 

 

A recent Sentinel 2 scene was downloaded from the Copernicus Open Access Hub 

(https://scihub.copernicus.eu/dhus/#/home), with the intention to perform land cover classification 

to identify the beach zone. The image chosen was a recent image, as no affordable 10m resolution 

imagery was available at the time of the hurricane, and the actual beach area has not changed 

significantly since that time. The imagery was processed in the SNAP software (SNAP - ESA Sentinel 

Application, 2019) using the ‘S2 Resampling Processor’ tool. This allowed me to create 10m resolution 

version of the 20m bands (Figure 3). Please note, the chosen scene was acquired using the 2A sensor 

and the spectral information in the table is specific to that sensor. 

 

Band Description Central 
wavelength (nm) 

Bandwidth 
(nm) 

Resampling 

2 Blue 492.4 66 - 

3 Green 559.8 36 - 

4 Red 664.6 31 - 

5 RE1 704.1 15 20m > 10m 

6 RE2 740.5 15 20m > 10m 

7 RE3 782.8 20 20m > 10m 

8 NIR 832.8 106 - 

8A NNIR 864.7 21 20m > 10m 

11 SWIR1 1613.7 91 20m > 10m 

12 SWIR2 2202.4 175 20m > 10m 
Figure 3. Sentinel 2A bands used in analysis. 

In the course of my research I identified a process called super-resolving, whereby the 20m bands 

could be resampled to 10m by a complex series of algorithms that would actually result in a dataset 

with additional information that could be used for multispectral classification. In some cases this may 

be useful, but given that we only want to identify beach areas which have a very distinct spectral 

signature, the process (which is very computationally intensive) was deemed unnecessary. 

https://scihub.copernicus.eu/dhus/#/home
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The resulting 10m dataset of 10 bands was processed in R and unsupervised classification performed. 

Unsupervised classification with two classes separated water and everything else. Unsupervised 

classification with 3 classes separated sand, water, and everything else. Visual inspection in ArcMap 

revealed that the classification of the sand areas resulting from a 3-class unsupervised classification 

was accurate enough for our purposes, and supervised classification was deemed unnecessary. Please 

see Section 7.3 of this report for the R code used for this step. 

The unsupervised classification was performed using the tool ‘unsuperClass’ from the R toolbox 

‘RStoolbox’. This tool implements a K-Means algorithm described by Hartigan and Wong (1979). 

 

2.3.3 Filtering of Unsupervised Classification Results 

Modal filtering reduced the complexity of the classification and resulted in a more continuous beach 

extent. Figure 4 shows an example of the result of this process, which will suit the purposes of the 

analysis. 

 

  

To neaten the data, further processing was performed. The beach is mostly a continuous area in 

reality, and the classification picked up some white building roofs and other small areas with a similar 

spectra signature that it would be useful to exclude. To achieve this, the raster was converted to 

polygons using the GRASS algorithm ‘r.to.vect’, with smoothing enabled. This was run inside an 

instance of QGIS, in preference to the native QGIS algorithms, as it is more efficient in handling large 

datasets. Small outlying polygons were filtered out manually by visual map inspection and deletion, 

assisted by area calculation for each polygon feature. The result of this process was a polygon 

shapefile, which will be referred to as the ‘Beach Area’ henceforth. 

The damage raster was cropped to the ‘Beach Area’ extent using the GDAL tool ‘Clip raster by mask 

layer’ running inside an instance of QGIS. 

 

  

Figure 4. Raw classification > Modal filter applied > Vectorised with GRASS smoothing algorithm. Beach is shown in white (raster 
classification cells) and yellow (final ‘Beach Area’ polygon). 
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2.4 ALONG-SHORE CHANGE PROFILE 
 

To examine height change along the entire coastline of the study area, a sampling strategy was 

employed to place a point roughly every kilometre along the beach. As our beach is a complex shape, 

it was not possible to draw a straight transect along its entire length. However, the study area is 

roughly north-south oriented, and this assisted in the design of a replicable sampling strategy. Points 

were spaced by 1000m in their UTM Northing value, and were assigned to the horizontal centre of the 

beach polygon at that northing. This is demonstrated in Figure 5. 

   

 

Sampling points were generated in QGIS version 3.12.2 using the following process, developed to suit 

the unique requirements of the sampling strategy: 

1) Created a 1000m x 1000m grid with the extent of the ‘Beach Area’ polygon (described in 

Section 2.3), using the tool Vector > Research Tools > Create Grid 

2) Horizontal lines only were selected from the grid using the following Select by Expression: 

y_min($geometry) = y_max($geometry) 

3) These horizontal lines were clipped to be the width of the ‘Beach Area’ polygon at their 

location by performing an Intersection analysis using the tool Vector>Geoprocessing 

Tools>Intersection 

4) The centre of each of these line segments was found using Vector>Geometry Tools>Centroids, 

thereby positioning the sampling point at the horizontal centre of the ‘Beach Area’ polygon 

for that UTM Northing value. 

The sampling points were used to extract raster values at their location. This was accomplished using 

the GRASS GIS tool “v.what.rast” running within QGIS. Using this tool, I added the value of the 

Figure 5. Sampling strategy 
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“Damage” raster created in section 2.2 to the attribute table of our sampling points. Next, I added the 

UTM Northing value for each point using the Field Calculator in QGIS. These attributes were then saved 

as a comma delimited text file and imported into Microsoft Excel. Excel was used to map the 

relationship between Northing and height-change. The results are presented in Section 3.3. 

2.5 CROSS-SHORE CHANGE PROFILES 
 

To further characterise the nature of the erosion patterns, I established three cross-shore transects in 

the Borough of Deal. These transects were used to create height change profiles to examine how 

erosion effect changed with distance from the shoreline. The Borough of Deal was chosen as it is 

anecdotally known to have been particularly hard hit by the Hurricane. The transects were 

purposefully positioned in a part of the coastline in Deal where a repeated pattern of heavy erosion 

close to the dunes was observed (please refer to Section 3.2 for further explanation of this 

phenomena). 

The transects were digitised in ArcMap 10.5, positioned to be approximately perpendicular to the 

shoreline. They extend from one edge of the “Beach Area” to the opposite edge, using the snapping 

tool. The location of the transects in relation to the Borough of Deal is shown in Figure 6 on the next 

page. 

These transects were used to obtain raster values for the PRE and POST Digital Surface Models using 

the following steps in QGIS: 

1) QGIS>Vector geometry>Points along geometry 

Added points every 1m along each of the transects using this tool 

2) Reprojected to points to EPSG: 3625 (the coordinate system of the DSM rasters) 

3) Used the SAGA tool “Add raster values to points” running within QGIS to add the values of the 

Pre-Hurricane, Post-Hurricane, and Damage rasters to the points file. 

4) Exported the attribute table to a delimited text file 

5) Plotted the results in Excel 

These results are described in Section 3.4. 
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Figure 6. Map showing location of cross-shore profile transects 
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3 RESULTS  

3.1 EROSION AND DEPOSITION PATTERNS – EXTREME CASES 
 

Erosion and deposition values were found to range from approximately -32m to 29m (see Figure 7). 

The values at the lower end of the spectrum most likely represent destruction of buildings. As the 

classification of the ‘beach extent’ study area used modern imagery, areas that are now sand once 

had buildings, and the extreme erosion values represent their destruction (see Figure 8). Whilst my 

first thought was to exclude these areas, they are an important result in their own regard, and one 

cannot in good conscience exclude these areas from the results. 

Min -32.20 

Max 28.62 

Mean -0.80 

Std dev. 1.07 
Figure 7. Statistics for the height change dataset clipped to beach extent. 

 

 

Figure 8. Extreme height decreases related to building destruction 

 

 



17 
 

The upper end of the change values, up around 29m, are possibly due to new buildings or the 

deposition of destroyed building material. The blue feature in Figure 9 shows a sudden height increase 

of between 12 and 20m, very close to a multiple areas of what appears to be building destruction. 

Each of the extreme height increase zones is similarly positioned, and I believe them to represent 

fallen buildings or destruction debris. 

 

Figure 9. Extreme height increases related to deposition of building debris 
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3.2 EROSION AND DEPOSITION PATTERNS – THE BEACH 
 

The remainder of the analysis is concerned with the change to the beach as a natural morphological 

feature, and extreme height change areas due to destruction of the built environment must be 

excluded for us to view these finer changes with sufficient detail. Extreme values with an elevation 

change greater than 10m were excluded on both sides of the value range, and erosion and deposition 

patterns and deposition was mapped using the following classes: 

Colour Lower Bound Upper Bound 

 
-9.78 -3.58 

 
-3.57 -2.62 

 
-2.61 -1.43 

 
-1.42 -0.48 

 
-0.47 0.71 

 
0.72 9.78 

Figure 10. Classes used for display 

 

The classes (Figure 10) are based on standard deviations about the mean (see Figure 11), both of which 

have been recalculated after the removal of extreme values. Erosion is symbolised by a colour ramp 

from yellow to red. Area with little changed are not coloured. And areas of significant deposition are 

coloured blue. This symbology was arrived at by a heuristic process of trial and error, with reference 

to standard cartographic principles. 

 

 

Figure 11. Determination of class break values showing mean and standard deviations as dotted lines. 
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Given that the study area is an elongated area roughly 100km long and 100m wide, the erosion and 

deposition patterns must be mapped in a series of maps to give a useful representation of what would 

otherwise be a very narrow feature. The extents of the tiles from the original LiDAR dataset provided 

a ready-made choice for the display extent of each map. A 1:20,000 map series is provided in Appendix 

B. All the maps in Appendix B are in WGS 1984 datum, UTM Zone 18N projection. An overview is 

provided here in Figure 12. 

 

Figure 12. Overview of map tiles presented in Appendix A. 
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The Morphological Change map series (Appendix B) shows that erosion has taken place along the 

entire shoreline of the study area. These maps suggest that the erosion is not uniform, but that it is 

patterned. 

Eleven of the nineteen morphological change maps reveal that the most heavily eroded areas lie 

towards the dune side of the beach. This is well illustrated in Figure 13 and Figure 14. The results of 

the cross-shore profile analysis supports and extends this pattern (described in Section 3.4). 

 

 

Figure 13. Excerpt from “Erosion and Deposition – Map J” 

 

Figure 14. Excerpt from “Erosion and Deposition – Map M” 
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3.3 ALONG -SHORE PROFILE 
 

The along-shore profile that resulted from the method outlined in Section 2.4 is given in Figure 15. A 

trend line has been calculated using a moving average of the nearest 10 values in an attempt to 

smooth the dataset in a meaningful way. 

 

Figure 15. Along Shore Profile showing height change for sampling points 

 

Of 100 sampling points, there was an average height reduction of 1.24m. 90% of the sampling points 

experienced height loss, and only 10% experienced an increase in height. This shows that erosion far 

outweighs deposition due to the storm. The coastline has been greatly eroded. Please see Section 4 

for further discussion of these results. 
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3.4 CROSS-SHORE PROFILES 
Cross shore profiles from the three transects in the Borough of Deal are presented in Figures 16-18.  

 

Figure 16. Transect 1, Deal Borough 

 

 

Figure 17. Transect 2, Deal Borough 
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Figure 18. Transect 3, Deal Borough 

 

The cross-shore profiles show that in all cases elevated features have experienced drastic levelling. 

The greatest height reduction has occurred in those parts of the cross-shore profile where a 

topographic elevation feature existed before the storm. This process has affected every raised feature 

in our transects, and hints at a significant and identifiable process at work that may be worthy of 

further study. Please see Section 4 for an interpretation of these results.  
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4 DISCUSSION AND RECOMMENDATIONS 

4.1 SIGNIFICANCE 
 

The results show that erosion has occurred along the entire shoreline of the study area. All maps in 

the ‘Morphological Change’ series (Appendix B) show erosion to some degree along the entire length 

of the beach. There is an average erosion of 1.24m from the sampling points, which is extreme in the 

context of the middle a beach zone where they were positioned. Whilst it can be said that extreme 

erosion has occurred, and far outweighs deposition, in this report I also aimed to characterise the 

nature of that erosion. Specifically, the context of this report is the premise that extreme weather 

events can change the morphology of a shoreline in a way that reduces its capacity to act as an 

important barrier to flooding of settled areas.  

Figures 13 and 14 above are examples of the pattern present in eleven maps of the 19 Morphological 

Change maps: that erosion is greatest towards the dune side of the beach area. The cross-shore 

profiles were established to investigate this pattern – what do they reveal might be happening? 

The cross-shore profiles (Figures 16-18 above) show that all features that present as a local 

topographic rise have been destroyed and levelled by the storm. These topographic features are 

almost certainly sand dunes. The implication is that this extreme weather event has levelled the sand 

dunes on the landward side of the shoreline. Cross-shore profiles were only established in the Borough 

of Deal, so it at this stage it is not possible to extrapolate this finding to the rest of the study area with 

any scientific reliability. However, this provides the impetus for the generation of a testable hypothesis 

for further research. 

Two points are of relevance: firstly, the same general pattern of greatest erosion towards the 

landward side of the beach area is observable along most of the coastline as revealed by the 

Morphological Change maps; secondly, when that pattern was investigated in the Deal area it appears 

to represent the destruction of the barrier dunes. Given these two points, there are strong grounds to 

hypothesise that Hurricane Sandy has damaged the sand dunes along much of the coastline in a similar 

way. If this is the case, then the case may be made that this extreme weather event has impacted the 

coastline in a way that has reduced its capacity to act as a barrier to inundation of settled areas. 

These findings echo those of Andrews et al. who found that the greatest storm erosion was occurring 

along the seaward face of dunes (2002). The findings, when examined in the light of the existing 

literature, show a clear path forward for further research. Pye and Blot examined which parts of a 

dune system experienced the most erosion, finding that this occurred where the upper beach was less 

than 25m wide (Pye & Blott, 2016) – does this relationship exist along the New Jersey shoreline? 

Certainly, erosion has occurred, and likely extensive barrier dune destruction has occurred. But is this 

phenomenon expressed to an equal degree along the entire length of the study area? As Burvingt et 

al. note, coastlines can exhibit a range of spatially variable and complex morphological responses, 

even though they have been subjected to the same extreme weather events (Burvingt et al., 2017, p. 

722).  

Further research is also required into the specific morphodynamics underlying the premise that dunes 

protect against inundation in this specific area. Fernández-Montblanc et al. discuss existing research 

in this direction (Fernández-Montblanc et al., 2020), but the focus has been on revegetation to 

stabilise dune systems: the morphodynamic role of dunes as a barrier to inundation has often been 
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taken as a given. Certainly, the height of a dune system relative to the storm surge must be the primary 

relationship in determining the potential of a dune-system to protect against inundation. At the very 

least, further research into recorded and predicted storm surge heights, and terrain modelling of the 

settled areas landward of the dunes should be undertaken before assumption are made pertaining to 

the role of the New Jersey dune systems in flood mitigation. 

4.2 LIMITATIONS  
The method for determining the ‘Beach Area’ could be improved. The method used (Section 2.3) 

resulted in an extent that did not include all beach when visually inspected: it is likely that this is due 

to the different spectral signatures presented by wet and dry sand (e.g. Sekovski et al., 2014). 

Unsupervised classification is an expedient approach that was appropriate given the constraints of 

this research, but a more accurate study area could be determined by using high resolution imagery 

contemporaneous with the study period, coupled with a supervised classification process using human 

digitised training data. Indeed, the ‘Beach Area’ extent is the weakest part of the analysis, with even 

some areas missed from the beach classification due to cloud cover (e.g. Erosion and Deposition – 

Map D in Appendix A). 

Burvigdt et al. digitised every beach area manually by drawing polygons in ArcMap, and it is possible 

that this would provide the most accurate and precise result (Burvingt et al., 2017, p. 725). Even in 

this case, the beach areas they defined are not perfect, as by their nature shorelines are dynamic 

phenomena. 

The along-shore profile (Figure 15) shows that erosion has been more extreme than deposition, but 

aside from this general statement, no other clear relationship exists between northing value and 

height change. Whilst there may be a relationship in reality, the sampling strategy employed in this 

study (described in Section 2.4) does not account for the complex nature of the shoreline change. At 

any one east-west transect through the beach zone, there are areas of deposition, erosion, and areas 

of no significant change: a sampling point in the center of this transect could lie in any one of these 

three situations. To characterise trends more accurately along the beach, a sampling strategy that 

averages the height change at that east-west location would be more appropriate. One approach 

would be to sum the area under a cross shore profile change curve every 1000m. These areas could 

be normalised by beach width. This approach could be carried out programmatically. 

It is important to note that this study has been performed using Digital Surface Models – derived from 

the first return measured by the LiDAR instrument. It is possible that Digital Terrain Models derived 

from the secondary returns captured by the LiDAR instrument would provide a more appropriate 

dataset for any further study where the intention was to focus solely on the morphological changes 

undergone by the beach sand. 
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5 CONCLUSION 

Shorelines provide an important barrier to flooding of settled areas. This report has demonstrated 

that extreme weather events have the potential to reduce the capacity of shorelines to provide this 

barrier. Whilst we have demonstrated that that this capacity has been reduced due to dune damage 

in the Deal area, we have not quantified the extent of this change for the study area as a whole. This 

study serves to highlight an important pattern that deserves more rigorous assessment – that the 

hurricane has actually destroyed dunes. Further work is required to assess and quantify this pattern.  

The findings in this report indicate that cross-shore profiles are a very powerful tool to assess the 

nature of shoreline erosion. Unless a suitable sampling strategy is employed, they are arguable more 

powerful than along-shore profiles. Further study could be directed to along shore profiles, but a more 

efficient approach is to work to understand the nature of the erosive patterns as they relate to the 

morphology of a shoreline at any one cross-shore transect. The relationships between erosion and 

shoreline morphological zones elucidated by this approach then have potential to be applied to any 

area. I feel that the cluster analysis approach of Burvingt et al. to investigate the relationship between 

erosion and morphological zones (2017) shows the greatest promise to further develop our 

understanding of the nature of storm induced shoreline damage. 

With the likelihood of increased extreme weather events in the coming years, it is critical that funding 

be directed towards increasing our understanding of the character of shoreline damage. This will 

directly inform shoreline damage mitigation strategies. In the coming decades, without the barrier 

that shorelines provide to storms and inundation, a large segment of the world human population will 

be put at risk, and a more compelling reason for research does not exist than to mitigate this suffering. 
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7 APPENDIX A 

7.1 R CODE FOR CREATION OF DSMS FROM RAW LIDAR DATA 
# CONSTANTS 

PRE_FOLDER <- "F:/ARS/Shoreline_Change/PRE" 

POST_FOLDER <- "F:/ARS/Shoreline_Change/POST" 

RESULTS_FOLDER <- "F:/ARS/Shoreline_Change" 

 

# Setup packages and Libraries 

install.packages("lidR") 

library(lidR) 

install.packages("mapview") 

library(mapview) 

 

###################################################### 

# PRE HURRICANE SECTION 

# Setwd 

wd<-setwd(PRE_FOLDER) 

 

#Read in catalog 

ctg_nj_pre<-readLAScatalog(wd) 

summary(ctg_nj_pre) 

plot(ctg_nj_pre) 

 

# add map background. EPSG3615. 

crs_nj<-sp::CRS("+init=epsg:3615") 

projection(ctg_nj_pre)<-crs_nj 

plot(ctg_nj_pre, map=TRUE) 

 

# Attempt to calculate full PRE raster 

wd<-setwd(PRE_FOLDER) 

ctg_nj_pre<-readLAScatalog(wd) 

dsm_full_pre = grid_canopy(ctg_nj_pre, res=2, algorithm = dsmtin()) 

setwd(RESULTS_FOLDER) 

writeRaster(dsm_full_pre, filename = "DSM_FULL_PRE.tif", format = "GTiff", ove

rwrite = TRUE) 

 

 

################################################## 

# POST HURRICANE SECTION 

wd<- setwd(POST_FOLDER) 

 

# Read in the las catalog 

ctg_nj_post<-readLAScatalog(wd) 

summary(ctg_nj_post) 
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plot(ctg_nj_post) 

 

# add map background. EPSG3615. 

crs_nj<-sp::CRS("+init=epsg:3615") 

projection(ctg_nj_post)<-crs_nj 

plot(ctg_nj_post, map=TRUE) 

 

# Attempt to calculate full POST raster 

wd<- setwd(POST_FOLDER) 

ctg_nj_post<-readLAScatalog(wd) 

dsm_full_post = grid_canopy(ctg_nj_post, res=2, algorithm = dsmtin()) 

setwd(RESULTS_FOLDER) 

writeRaster(dsm_full_post, filename = "DSM_FULL_POST.tif", format = "GTiff", o

verwrite = TRUE) 

 

 

 

 

7.2 R CODE FOR CREATION OF DAMAGE RASTER 
 

################################################ 

# RASTER MATH SECTION 

# Calculate difference raster 

post_pre<-dsm_full_post-dsm_full_pre 

plot(post_pre) 

setwd(RESULTS_FOLDER) 

writeRaster(post_pre, filename = "Damage_FULL.tif", format = "GTiff", overwrit

e = TRUE) 
 

 

7.3 R CODE FOR UNSUPERVISED IMAGERY CLASSIFICATION AND MODAL FILTERING 
# Import libraries (already installed) 

library(RStoolbox) 

library(raster) 

 

# Southern Image - stack bands into a single raster 

wd<-setwd("C:/ARS/Shoreline_Change/Sentinel/T18SWJ_BANDS") 

Sb2 <- brick('b2.img')  

Sb3 <- brick('b3.img')  

Sb4 <- brick('b4.img')  

Sb5 <- brick('b5.img')  

Sb6 <- brick('b6.img')  
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Sb7 <- brick('b7.img') 

Sb8 <- brick('b8.img')  

Sb8A <- brick('b8A.img')  

Sb11 <- brick('b11.img')  

Sb12 <- brick('b12.img')  

 

south <-stack(Sb2,Sb3,Sb4,Sb5,Sb6,Sb7,Sb8,Sb8A,Sb11,Sb12)  

plotRGB(south, r = 3, g = 2, b = 1, stretch = "lin")  

writeRaster(south, filename="south.tif", options="INTERLEAVE=BAND", overwrite=

TRUE) 

 

# northern Image - stack bands into a single raster 

wd<-setwd("C:/ARS/Shoreline_Change/Sentinel/T18TWK_BANDS") 

Nb2 <- brick('b2.img')  

Nb3 <- brick('b3.img')  

Nb4 <- brick('b4.img')  

Nb5 <- brick('b5.img')  

Nb6 <- brick('b6.img')  

Nb7 <- brick('b7.img') 

Nb8 <- brick('b8.img') 

Nb8A <- brick('b8A.img')  

Nb11 <- brick('b11.img')  

Nb12 <- brick('b12.img')  

 

north <-stack(Nb2,Nb3,Nb4,Nb5,Nb6,Nb7,Nb8,Nb8A,Nb11,Nb12)  

plotRGB(north, r = 3, g = 2, b = 1, stretch = "lin")  

writeRaster(north, filename="north.tif", options="INTERLEAVE=BAND", overwrite=

TRUE) 

 

# Coregister the Imagery 

wd<-setwd("C:/ARS/Shoreline_change/Sentinel") 

north_south<- RStoolbox::coregisterImages(north, south, verbose = TRUE) 

# "Identified shift in map units (x/y): 0/0" 

 

# Histogram Match and Merge 

# north + south 

north_hm<-histMatch(north, south) 

north_south<-merge(north_hm, south) 

plotRGB(north_south, r = 3, g = 2, b = 1, stretch = "lin", axes= TRUE, main="n

orth, south merged") 

 

# Output our merged image 

writeRaster(north_south, filename="NJ_S2_merged.tif", options="INTERLEAVE=BAND

", overwrite=TRUE) 

 

# Unsupervised Classification 

# read in raster from file again to allow this part of the code to be run afte

r closing session: 
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wd<-setwd("C:/ARS/Shoreline_change/Sentinel") 

north_south <- brick("NJ_S2_merged.tif") 

 

set.seed(100) 

uc3<-unsuperClass(north_south, nClasses=3, nStarts = 50, nSamples = 1000) 

plot(uc3$map) 

writeRaster(uc3$map, filename="NJ_uc_3class.tif", options="INTERLEAVE=BAND", o

verwrite=TRUE) 

 

# Modal Filtering 

window <-matrix(1,7,7) 

NJ_uc3_mode<-focal(uc3$map, w=window, fun = modal) 

NJ_uc3_mode$layer 

writeRaster(NJ_uc3_mode$map, filename="NJ_uc3_mode.tif", options="INTERLEAVE=B

AND", overwrite=TRUE) 
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APPENDIX B 

1:20,000 MAP SERIES OF MORPHOLOGICAL CHANGE 
 

Please note, his page has intentionally been left blank, the map series will begin on the following 

page.  


